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1 Introduction 

This quick guide provides basic instructions and information to setup CathexisVision.1 The objective of this 
document is to get the software up and running as quickly as possible. For more detailed information (such as 
configuring video analytics, Failover, etc),  please consult the Setup Manual or contact support at 
support@cat.co.za. 

 

Please note that in order to use this document and software, the assumption is that the installer has a basic 
understanding of the operating system, and is able to do simple administrative tasks (for example, adding disks, 
adding printers, or setting IP addresses). 

 

 

                                                           
1 While Cathexis has made every effort to ensure the accuracy of this document, there is no guarantee of accuracy, neither 
explicit, nor implied. Specifications are subject to change without notice. 

mailto:support@cat.co.za
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2 Requirements/Restrictions 

Please download CathexisVision Software (www.cathexisvideo.com) to continue with this document. 
 Note: there is a minimum requirement of 4 Gigabytes of RAM to run this software. 

 Supported Systems 

Listed below are the supported/not supported operating systems. Supported systems apply to all contents of 
CathexisVision software install, including: 

1. CathexisVision software. 

2. Map Editor. 

3. Archive Viewer. 

 Not Supported   

The following systems are not supported: 

• Windows XP and earlier. 

• Windows Vista. 

• Windows Server 2008. 

• Linux Fedora 16 (only supported up to CathexisVision 2018 and earlier versions). 

• NetBSD. 

 

 Supported Linux Systems 

• Ubuntu 12.04 LTS Desktop (32-bit). 

• Ubuntu 16.04 LTS Desktop (64-bit). 

 Supported Windows Systems 

• Microsoft® Windows® 7 SP1. 

• Microsoft® Windows® 8 . 

• Microsoft® Windows® 8.1. 

• Microsoft® Windows® 10 . 

• Microsoft® Windows® Server 2008 R2 SP1. 

• Microsoft® Windows® Server 2012. 

• Microsoft® Windows® Server 2012 R2. 

• Microsoft® Windows® Server 2016. 

• Microsoft® Windows® Server 2019 
 

Note:  

CathexisVision 2020 is the last release to support Windows 32-bit installs. 

CathexisVision 2020 is the last release to support Ubuntu 12.04. 

 

 Windows Update Requirements 

The Universal C Runtime Update is required for certain systems. From CathexisVision 2017 onwards, updated 
Windows runtime libraries are used. This means that the Windows 10 Universal C Runtime update must be run 
on systems prior to Windows 10 (see list below). 

 

http://downloads.cathexisvideo.com/
http://www.cathexisvideo.com/
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Note: From CathexisVision 2018.3 onwards, Windows Vista and Windows Server 2008 are no longer supported, 
thus the update no longer applies to those systems. Windows Server 2008 R2 is still supported. 

This update requirement applies to: 

• Windows Server 2012 R2. 

• Windows 8.1. 

• Windows RT 8.1. 

• Windows Server 2012. 

• Windows 8. 

• Windows RT. 

• Windows Server 2008 R2 Service Pack 1 (SP1). 

• Windows 7 SP1. 
 
Windows XP and earlier is not supported. 
 
Windows updates can be run, or the specific update KB2999226 may be run. The Windows 10 Universal C Runtime 
update can be downloaded from: https://support.microsoft.com/en-us/kb/2999226. 
 
Running the KB2999226 update has prerequisites, and the following software may need to be installed: 

• Windows 7 Service Pack 1 (download from http://windows.microsoft.com/installwindows7sp1). 

• Windows Server 2008 Service Pack 2 (download from https://support.microsoft.com/en-us/kb/968849). 

• Windows Server 2008 R2 Service Pack 1 (download 
fromhttp://go.microsoft.com/fwlink/?LinkID=199583). 

• Windows RT 8.1, Windows 8.1, and Windows Server 2012 R2 update 
o KB2919442 (download from https://support.microsoft.com/en-us/kb/2919442). 
o then KB2919355 (download from https://support.microsoft.com/en-us/kb/291935). 

 Hardware Requirements 

The CathexisVision software architecture is designed to utilise the various hardware system components with 
maximum efficiency. When choosing the right server hardware, there are many system issues to be taken into 
consideration. Some examples are: 

• Camera resolution. 
• Camera bitrates for recording. 
• Camera Frame rates and resolution for “live” viewing. 
• Whether using the IP camera or the Cathexis software to perform Video analytics. 
• Whether viewing cameras “live” from the same server on which the user is recording. 
• Whether “multicast” video is being streamed from the camera. 
• Storage methodology (on-board, Network Storage etc.) 
 

 Hardware Selection Guidelines 

The table below provides guidelines to assist in choosing hardware for the application. The figures in the table 
were generated using the CathexisVision Design Tool www.cathexisvision.com  

Note that the following parameters were used to determine these guidelines: 

1. These are conservative figures for recording servers only. 
2. Live viewing is not included in these numbers. 
3. 3MP cameras with a 3MP/24fps recording stream. 
4. CIF/12fps analytics stream running Smart VMD. 
5. External storage on a 1/10 Gbps network. 

https://support.microsoft.com/en-us/kb/2999226
https://support.microsoft.com/en-us/kb/968849
http://www.cathexisvision.com/
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 Note: These guidelines are not exhaustive. For assistance with design, contact a distributor or a Cathexis regional 
office. Alternatively, navigate to cathexisvideo.com and use the Design Tool. 

Processor RAM (GB) Server Storage throughput 
Mbps 

No. of 3MP cameras per 
server 

i7-7700k 4.20GHz 16 600 152 

Xeon E3-1290 V2 3.70GHz 16 500 122 

Xeon E5-1680 V4 3.40GHz 32 700 187 

Xeon E5-2640 V2 2.40GHz 32 650 164 

Xeon E5-2695 V3 2.30GHz 32 900 223 

Xeon E5-2699 V3 2.30GHZ 32 1000 253 

 

 Anti-Virus Exclusions 

If running an anti-virus with active or real-time protection scanning enabled, certain CathexisVision folders 
need to be excluded from anti-virus scanning in order for CathexisVision to run correctly.  

 

The folders which need to be excluded are: 

 

• CathexisVision Server installation folder. 

• CathexisVision Client installation folder. 

• Any folders, drivers, and volumes where the database/s reside. 

 

Note: All folders and paths referred to below are default installation folders – if the default folder option was 
not selected during installation, then locate and exclude installation folder/s from anti-virus scanning. 

 

The sections below indicate the default installation folders and paths, which need to be excluded from 
scanning. 

 

 Folders to Exclude from Anti-Virus scanning in CathexisVision 

For sites running CathexisVision 2016 and/or 2017, please exclude the following from anti-virus scanning: 

CathexisVision Server 

Folders to Exclude 

 

32-bit c:\program files (x86)\CathexisVision 
Server. 

64-bit c:\program files\CathexisVision Server. 

CathexisVision Client 32-bit c:\program files\CathexisVision Client. 

Database 
folders/drives/volumes 

 

Please locate and exclude. 
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 Complete List of Folders to Exclude  

If the system uses a global anti-virus (meaning anti-virus protection is applied globally and not to individual units) 
and the different units in the site may have different installation folders, or if the installation is prior to 
CathexisVision 2015, then simply exclude all the default installation folders to avoid hassle. 

 

Note:  All folders and paths referred to below are default installation folders – if the default folder option was 
not selected during installation, then locate and exclude installation folder/s from anti-virus scanning. 

 

CathexisVision Server 

Folders to Exclude 

 

c:\program files\Cathexis CathexisVision Suite NVR. 

c:\program files (x86)\Cathexis CathexisVision Suite 
NVR. 

c:\program files\CathexisVision Server. 

c:\program files (x86)\CathexisVision Server. 

CathexisVision Client 

c:\dvs. 

c:\program files\Cathexis CathexisVision Suite WRV. 

c:\program files (x86)\Cathexis CathexisVision Suite 
WRV. 

c:\program files\CathexisVision Client. 

c:\program files (x86)\CathexisVision Client. 

Database folders/drives/volumes Please locate and exclude. 

 

 Third-Party Anti-Virus Real Time Scanning on CathexisVision Clients 

On a CathexisVision Client unit, the CathexisVision Server folder needs to be manually excluded from scanning by 
Windows Defender or other third-party anti-virus real time scanning components. 

 

 Routing/Port Requirements  

The following information regards the router ports that need to be opened on the network firewall/router/anti-
virus. These ports are important in allowing several Cathexis services to run correctly. Please ensure that these 
ports are also open on the anti-virus (if running one). 

 Ports to Open 

 

Operational Ports Protocol Application Description 

80 TCP Default CatMobile Access Port required to allow CatMobile client 
connection to server. 
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30010-30100                TCP CathexisVision Software Required ports for access to the CathexisVision 
software and associated configuration, live and 
recorded view, etc. 

30014 TCP API (CathexisVision 2016 
and previous versions)* 

Required port to allow API connection to server 
when using software CathexisVision 2016 and 
previous versions. 

 

Note: Video also needs to be streamed from the 
server using TCP port 30010. 

33104 TCP API (CathexisVision 2017 
and later versions)* 

Required port to allow API connection to server, 
when using software versions CathexisVision 
2017 and later. 

 

Note: Video also needs to be streamed from the 
server using RTSP on TCP port 554. 

* For the full list of API ports, please consult the API help guide or contact support@cat.co.za 

 

Maintenance Ports Protocol Application Description 

22 TCP Secure Shell (SSH) – 
Linux 

Port required to enable remote access to Linux 
server using Secure Shell network protocol. 

3389 TCP Remote Desktop – 
Windows 

Port required to enable remote access to 
Windows server using Remote Desktop 
application. 

NA NA TeamViewer Access Application for allowing remote access to a 
Windows server. No port required. 

 

 Remote Support 

Please download and install one of the following programs relevant to the operating system to ensure 
remote support is available. 

 

Linux: Secure Shell (SSH - TCP port 22). 

Windows: TeamViewer, Any desktop, or Remote Desktop. 

mailto:support@cat.co.za
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3 Installation 

Double-click the installer file to open the Installation Wizard.  
 

 

 Follow the installation Wizard 

 

1 

 

2 

 

 Click Next.  Accept the End User License Agreement. 

 

3 

 

4 

 

 The user will be prompted to choose between a Full 

NVR System and a Failover System installation. 

 Choose the installation folder (this is best left as 

it is.) 
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5 

 

 

Click Install, and when the installation is 

complete, click Finish. 
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 Failover Installation 

After a successful Failover 
installation,2 attempting to initiate 
CathexisVision (by double clicking on 
the CathexisVision icon) will open the 
following dialogue box: 

 

 Cathexis Windows Performance Wizard 

The Cathexis Windows Performance Wizard optimises several Windows system settings for use of the 
CathexisVision Software on a Microsoft Windows Server. It is run after a successful installation and may be 
run anytime thereafter to change the settings. 

 
 

The installer shows the current state of each setting. It presents the following options: 

 

Filesystem Optimisations: 
 
* Disable last Access timestamp for NTFS partitions: 
 
Required - By default, when a file is accessed, NTFS writes information to record when the file is last accessed. 
To improve NTFS disk performance disable the NTFS last-accessed timestamp. 
 
Power Management: 
 
* Enable the High-Performance power management scheme. 
 
Recommended  

Adjusts the Windows power scheme settings to ensure uninterrupted recording and live viewing. 
 
Background Services: 
 
* Add exceptions to Windows Defender  
 

 

                                                           
2 There is detailed information about Failover in the Setup section of the CathexisVision manual. 
 

http://cathexisvideo.com/video-management-solutions/video-management-software/cathexisvision-manuals/
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 Recommended  

Will provide a performance gain for the caching and writing of video to the underlying software and database 
folder locations. Refer to section 2.4 above for more details. 
  
* Disable Windows Search Indexing 
 
Recommended  

Provides a significant performance gain by preventing background indexing of the file system. 
 
 

 

 Start CathexisVision 

This is the user interface where the recording parameters are configured. It allows the user to view live video 
and review recorded video. 

 

 Log in 

 

Default Login Details 

Username: admin 

Password: admin 
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4 Licensing  

The mode of licensing will depend on whether the license task is being performed on the local unit (the unit 
being worked on), or a remote unit (this being a viewing unit on which a copy of the software is installed). This 
section provides a guide for each situation.  
 
For details on the licensing structure of CathexisVision, please consult the Software Product Description and 
License Document, or contact support@cat.co.za.  

 Trial License 

Once CathexisVision is installed, a trial license is automatically applied to the system. To license the system 
further, consult the relevant licensing sub-section. 
Features of the trial license include: 
 

• Two permanent IP camera licenses.  

• Maximum recording review time of two days. 

• Standard CathexisVision basic analytics.  
 

Trial licenses that unlock additional features may be requested from support@cat.co.za.  

 

 Recording Review Time 

With a trial license applied, only two days (48-hours) of recordings may be reviewed at a time. The camera will 
continue to record to database (provided there is space, the cameras have the requisite bitrates, etc.), but 
review of the recordings will be restricted to two days (48-hours) from the point of review. Apply the relevant 
licenses to unlock the database and review all recordings for as far back as the database has recorded. 

 

 Licensing from a Local Unit 

The following instructions describe the process for licensing the unit that is currently being worked on. For 
licensing a remote unit, see the next section (Licensing from a Remote Unit). 
 

 Internet Connection: Product Key 

With access to the internet, and a product key supplied from a vendor, enter the product key. The system will 
connect to the online licensing system and complete the process.  

 

 No Internet Connection: Pack File 

If the unit the user is performing the licensing from, does not have internet, upload a .pack file. A pack file is a 
file that contains all the licensing information for a unit.  

 

To get a .pack file from support@cat.co.za, there are two steps. First, save a .rqst (request) file, from the unit 
being licensed, and email this to support, along with the information relevant to the licenses being added to this 
unit. Support will then respond with a .pack file, containing the licenses, which can then be uploaded to that 
unit. 

 

mailto:support@cat.co.za
mailto:support@cat.co.za
mailto:support@cat.co.za
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 License Request File 

A .rqst file must be retrieved from the unit being licensed.  

 
 

 

 

 

 

Email this .rqst file to support, along with the information relevant to the licenses being added to this unit. 

 

 Upload .pack File  

 

 
Your site should now be licensed. For further assistance, contact support@cat.co.za.  

 

 Licensing from a Remote Unit 

When licencing from a remote unit (i.e. licensing a unit that is not the one being worked on), the procedure is 
different. This is because when clicking Tools → Licensing, the unit currently logged in on will be the one that 
is licensed.  

 Open Configure Servers  

To open Configure Servers, of the site logged into, follow this path from the menu bar: Site → Open Tab → 
Setup.  

Once in the setup tab, click on the Configure Servers icon . 
 

 

Once Configure Servers is open, right click on the individual unit to license and select 
Licensing from the drop-down menu. 

 

 

 

After this, the licensing procedure is the same as if Tools — 
Licensing had been selected in the GUI of the local 
machine. 
 
The options seen here on the left will appear.  
Auto-update if this unit has already been licensed, or use 
a Product Key if one was provided. 
To request a license, follow the procedure detailed in 4.2.2 
No Internet Connection section. 
 
 

mailto:support@cat.co.za
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Note: Save the .rqst files, and upload .pack files, to storage media attached to the unit the licensing is being 
done from, not the one being licensed. Always retain the .rqst file & the .pack file for future licensing support. 
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5 The Setup Tab 

CathexisVision may run on one individual recording server, or on many interlinked servers. Cameras, and 
integrated devices, are added to individual servers. For this reason, many of the setups are done on a server-by-
server basis. Server-based setups occur in the Configure Servers section of the Setup Tab. 

 Open the Setup Tab 

There are two general ways of navigating to the Setup Tab: 
 

1. File → Open Site → Site_Name 
 

 
 

2. Site → Open Tab → Setup 
 

 
 

 General Setup   

 

From the general setup, set the site name, 
default access levels, site contacts, 
network speed, and operator archiving 
profiles. 
 
Once these changes are made, click 

 for them to take effect.  
 



 

005-20200818-267  16 November 2020                                                              Page 7 

 

6 Cameras  

This section of the manual will detail methods for adding cameras, followed by an examination of the Camera 
Editing options, and some extra information on the right-click menu. 

 Adding Cameras 

There are two ways to add a camera in CathexisVision.  
1. The camera Addition Wizard. (This also provides the option to add databases, schedules, and events to 

the system.)  
2. The Copy/Paste Function.  

 
For either method, enter the Cameras Panel, which is located under Configure Servers. 

File → Your_Site_Name → Open Tab → Setup → Configure Servers  → Expand the appropriate Server 

→ . 
 

  Addition Wizard 

The camera addition wizard guides the user through all steps needed to add a camera, as well as allowing for 
the creation of databases, schedules, and events in the setup process. There are two phases in the Addition 
Wizard:  

1. The addition of the camera.  
2. Setting up the system to record from that camera (either via a Video Motion Detection (VMD) event, or 

via a scheduled recording). 
 

To start the camera addition wizard, click on the  button at the bottom of the cameras panel. This 
will begin the wizard. The following guides the user through each step in the wizard. 
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  Connection 

The first step in the Wizard is the Camera Connection step. Here, set up all the connection details of the camera. 

 Note on Scanning: 

1. Some Cameras do not support automatic location requests, and will not be found using Scan. 
2. Universal Plug and Play (UPnP) will have to be enabled on the cameras that do support location requests. 
 

 

Driver: Select the relevant 
driver for the camera. 
IP Address:  Set the IP address 
of the camera being added. 
Scan: will scan the network 
for cameras that have been 
set up to make themselves 
available. Click on a camera 
and it will automatically set its 
driver and IP address. 
Camera name: the 
descriptive name given to the 
camera. 
Video Input: use if connecting 
to an encoder that has 
multiple analogue inputs (if 
not, leave it on 1). 
Port: has a default setting, but 
to connect through a specific 
port, set it to the port of 
choice. 
Login and password: the 
cameras’ current login 
details. 
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  General Settings 

 

See the table below for a 
description of this window. 
 
Note: The image in the 
preview will not reflect the 
actual quality of the feed, as it 
is transcoded when viewed in 
the camera addition wizard. 

 
 

 
 

 Add/Edit Video Feeds 

To add/edit a video feed, click on one of the available feeds in the list, and click on the Edit button. This will 
bring up a feed dialogue with the available video feeds, and the options that pertain to them. The two most 
common IP feeds are JPEG and H.264. 

Name Give the camera a descriptive name. So as to make it easily identifiable in a list. 

Covert CathexisVision provides the option to create a covert camera. There is a difference 
between a camera being covert, and a user not having access to it. 

Covert Access Level Defined 

Will only be present in the Resources 
List of an Administrator, or an access 
level that has been granted access to 
this camera 

Will still appear in the Resources List of 
lower login levels, but they will not be able 
to view the feed. 

Camera 

Information 

This will be a list of all the relevant information, pertaining to the device itself. View it 
underneath the image preview. 

Live Preview 
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 JPEG 

 
 
 
 
 
 
 
 
 
 

Transmission will show the transmission type. 
Format is the compression format used by this stream. 
Click the drop-down menu to choose the one desired. 
Resolution is the number of pixels in the image. 
Framerate is the number of frames recorded per second. 
Quality defines how lossy the compression of the image 
is. At 100 the image will have the best quality; at 50 it will 
have the lowest. 
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  H264 

 

  
 
 
 

 Multicast 

Setup Multicast on feeds by selecting the relevant option from the feed dialogue. There are three options; 
disabled, auto, and manual. Leave Multicast disabled if it is not desired. 
 

 Manual 

 

With manual selected, enter the Multicast IP, and Multicast Port. 
 

 
Auto 
On auto, the Multicast address will be automatically assigned. The core settings for this may be found in the 
Setup Manual. 
 

 Feed Notifications  

 

This area displays the status of the feeds created: 
Recording, Live Viewing, or Analytics. 
 

 
Note: If clicking on any of the above icons, they will display detailed information regarding the feed/problem. 
 

Transmission will show the transmission type. 
Format is the compression format used by 
this stream. Click the drop-down menu to 
choose the one desired. 
Resolution is the number of pixels in the 
image. 
Framerate is the number of frames recorded 
per second. 
Bitrate Type is the way the bitrate is handled. 
A constant bitrate will be more predictable, 
but will lose more information the more the 
image changes. Variable bit-rate is less 
predictable, but will have better images when 
the picture has more motion. 
Bitrate is the amount of information, in bits, 
that the feed will send per second. (Quality 
defines how lossy the compression of the 
image is.) 

Key Frame Distance is the number of frames 
between each I-Frame (Key Frame). 

Key Frame rate: demonstrates frame rate 

Audio: Can be disabled or enabled. 

Multicast: Can be disabled or enabled. 

 



 

005-20200818-267  16 November 2020                                                              Page 12 

 

 Automatic Configuration 

If there is an  icon at the end of the feed notification, this means that there is a potential problem with the 

feed setup. Clicking this  will automatically fix the problem.  

 Right-Click Menu (Live, Recording, and Recording Channel Settings) 

Right-clicking on a feed, after it is set up, will bring up the menu below. These are settings that can only be 
accomplished after the feed is up and running.   
 

 
 

Disable Live viewing of the feed. 
Disable Recording of the feed. 
Set Recording Channel Define which channel number will represent 

this feed. 
Enable Analytics Enable Video Analytics. 

 

 

 Analytics 

In order to enable analytics on a unit, configure a second feed, right-click on that feed, and click Enable Analytics. 
There are a few rules when it comes to enabling analytics. 
 

1. If an analytics-enabled channel is not set up here, there will not be a prompt to add VMD later in this 
wizard, nor will it be possible to add VMD, using this feed later. 

2. Only Feeds that are QVGA resolution, and lower, will give provide the option to enable analytics. 

3. A   at the end of the   feed notification, means there is not a feed enabled for analytics. 

Clicking on  will automatically enable one. 

4. Note: If the user chooses to proceed without enabling analytics, a prompt will appear. One can also 

enable video analytics by this route. 
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 I/O 

The next step in the addition is the I/O setup. The I/O values represented in the GUI will depend on the I/Os 
provided by the encoder. 
 

 I/O 

Inputs are used to trigger an event; Outputs are 
used to give a desired output as a result of a 
triggered event. 
 

Renaming 

 

Double click on 
the I/O name 
to rename it. 

Enabling 

 

Double click on the red cross, or click 

the enable button. Once enabled, it 

may be used to trigger an event. This 

may also be done by right-clicking. 

 

 

 Edit an Output 

 

      

 Triggers 

 

Name 
Give the output a descriptive name. 
 
Enabled  
Displays whether the output is disabled/enabled. 
  
Pulse duration 
Will set the amount of time (in milliseconds) that the 
output will pulse for, if set to pulse. 
 
Pulse only  
If set to Yes, the output will not allow itself to be 
permanently set. 
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 Certain cameras will have their own event triggers, 
and encoders will often have I/O options . 
 

 
Note:  

• Double clicking on any of the column values of an I/O will toggle the value. E.g. double clicking on a Clear 
state will change the state to Set). (These options are also available via the Right-Click menu.) 

• Give the I/Os descriptive names, otherwise they will not be identifiable.  

 Serial Ports 

 

 Camera Edge Review Setup 

 

Cameras which support 
Edge recordings will have an 
additional tab in the camera 
wizard, which enables 
viewing of the camera’s 
onboard Edge database 
within CathexisVision. 

 

Select Yes from the drop-
down menu to enable the 
database. 

 

When this is enabled, the 
camera’s Edge database will 
be available for selection in 
camera review, as with 
other CathexisVision system 
databases. 

 

If this is disabled, the 
database will not be 
available for selection. 

 

Highlight the serial port to configure, then click the 

 button.  
 
This provides the option to change the Baud rate, Data 
bits, Parity,  Stop bits, and other camera dependent 
settings. 
 
Note: This option will only be available if the camera has 
serial ports.  
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  Pan-Tilt-Zoom (PTZ) 

Check the  box, if a PTZ camera is being added. After this, all the available PTZ options will appear 
in the wizard interface: 

 General Settings 

PTZ channels can be added in two ways either by selecting Onboard or a Serial Port.  

 
 
 

Note: These options can vary on a camera-by-
camera basis. 

 

Preset Name Give Presets descriptive names (such as ‘front door’ etc.) 

Zoom Speed This defines how fast the camera will zoom in when using the PTZ controls.  

Note: Use the live view panel, at the bottom of the Resources Menu, to see if the zoom 
speed is satisfactory.  Test the PTZ zoom in the setup PTZ control, or use the PTZ control 
option from the resource panel of the camera view. 

 
Home 
Position 

A home position is a pre-set position to which the camera will return to after a set period of 
inactivity. 
 
Automatic Return to Home 
Set a schedule, during which the camera will return to its home position. When the schedule 
(see: Error! Reference source not found.) is inactive, the camera will remain in the last position t
hat it was left in. If there is no schedule set, the camera won’t return automatically to its home 
position.  
 
To have it always return home after a period, simply enable the Every Day schedule. 

Switch Wash 
and Wipe 
Relays 

In the case that the Wash and Wipe relays are incorrectly attributed, this will swap them over 
to the correct order. 

Configure PTZ 
tours 

A PTZ tour will run through a sequence of pre-set positions.  (See section immediately below.) 
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 Configure PTZ Tours 

If the device supports Tours, to create/edit a PTZ tour click on . This navigates to the list of 

tours. To create a new tour, click .  

 

 

 

Name and Schedule 

 

Give the tour a descriptive name, and, if desired, a 
schedule (see: Error! Reference source not found.) 

 

Sequence 
This is the sequence that the Presets will run in. 
 
 

 Add Preset, Multiple Presets, or a Pattern, to the tour 

 
Preset 
Select the Preset, set how long the camera should linger at this Preset. 
 

 
 
Multiple Presets 

• Starting at: Select the first Preset to add. 
• Add: This is the number of Presets being added. 

 
In the example below, Presets 4 to 6 will be added. 
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Pattern 
Select the pattern to add. 

 
 

 PTZ Procedures  

 
 

Note: Don’t forget to select/play a live feed. 

 

 

 

 Using the PTZ Control Panel 

Pan Left/Right: 

 Drag joystick left / right. 

Tilt Up/Down: 

Drag joystick up / down. 

Move Camera Faster: 

Distance determines speed - drag joystick out, in required 
direction. 

 

Move Camera Slower: 

Distance determines speed - drag joystick 
closer in, in required direction. 

 

Zoom In/Out: 

Watch the live camera, while pressing the Zoom + and 
Zoom – button. 

Focus Further/Closer: 

Watch the live camera, while pressing the 
Focus + and Focus – button. 

Go to Preset: 

1. Select the Preset from the dropdown, and then 
click GO. 

2. The camera view will change to the Preset. 
3. To relinquish manual control of the dome/PTZ 

camera from the PTZ panel, click Auto. 

Gain Control of Dome/PTZ: 

(Applies if system runs remote tours 
automatically, or switches display based on 
events.) 

 

Either click manual, or simply move the 
software joystick. 

 

With a Pan-Tilt-Zoom (PTZ) camera, an operator can 
manipulate the camera’s direction, Zoom, focal distance 
(Focus), and amount of light (Iris). The operator can also 
control pre-configured camera views called “Presets”.  

A Dome Control Panel becomes available when a Live 
PTZ camera is selected in the CathexisVision interface.  

Click the panel’s dropdown menu and select PTZ (see 
below). The software joystick displays: 
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4. If the system runs remote tours automatically, or 
switches displays based on events, these 
automated responses will take over. 

Lighten/Darken Live Camera View: 

Press the iris+, or iris – button. The image will lighten or 
darken. 

Define a Preset: 

1. Select the Preset number, from the 
dropdown menu.  

2. Use the joystick controls to establish the 
camera View, Zoom, Focus, and Light (Iris).  

3. Click SET. 

4. Go to this Preset to check it. 

 PTZ Priority Control 

 

Control of a PTZ camera works on a priority system to determine who gets control of the camera should more 
than one user at a time attempt to control the camera. Administrators get the highest priority, after which the 
priority hierarchy runs from user level 30 down to user level 1. For example, should a level 10 user and a level 1 
user attempt to control the PTZ camera, the level 10 user will get priority control. An administrator would get 
priority over both. 

Note:  

1. If two users of the same user level attempt to control the camera, then the first user gets priority and 

the second user will have to wait until the ‘Dome override’ period has elapsed. 

2. Manual control of the camera takes priority over event-initiated/auto control of the dome. 

 

 Configure Camera 

 

The operator can now add motion recordings and configure camera access rights. 
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 Enable scheduled recording 

 

Scheduled recording can be enabled in the Camera addition wizard. Here, set Database, Schedule, Channel, 

Framerate, and Condition. 

 

 
 

 Enable motion recording 

This can be accessed by visiting Setup → Configure Servers→  Expand the Server → Motion Recording. 

Motion recording can be enabled. here, the user can set Database, Schedule, Scene, Sensitivity, Recording 

time before and after motion, Channel, Framerate, Flare Suppression, Noise Suppression, and Condition. 

One can also Add mask and Test settings.   
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 Enable analytics recording  

  
 

 
 

 

 

 

 

 

 

 

 

 

 

 

When configuring analytics, under the 
Event tab, set:  

Name, Database, Schedule, Recording 
channel, Frame-rate, and Pre-event. 

When configuring 
analytics under the 
Event tab, set Zones, 
Advanced options, 
Day/ Night settings, 
and Triggers.  

 

Advanced video 
control may also be 
used.  
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 Configure access rights 

 

Configure relevant Access rights by clicking the Configure access rights button.  

 

 

 

 Copy/Paste Cameras 

If adding more than one camera that operates on the same driver, CathexisVision offers a very easy solution.  
Copy and paste new cameras, using the addition information of one previously added camera.  
 

To Paste New cameras, right-click on the previously added camera and click . Then right click anywhere in 
the Cameras Panel and click . 
 

 Paste Mode: Sequential 

The paste mode sequential window provides the option to add the new cameras as a direct copy of the camera 
that copied.  
 

 

Start IP Address will determine the IP address of the 
first new camera being added. The IP addresses will 
be incremented from here. (So, make sure no IP 
addresses in this range have been used.) 
Total channels on encoder must be the full number 
of camera channels available on this encoder. 
Start Input is the actual physical channel that the first 
camera is added to. 
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 Paste Mode: Discovered 

 
 
Note:  This will copy the video settings from the copied camera onto the discovered cameras selected. 
 

 Copy/Paste Video Settings 

If a number of cameras with the same drivers have already been selected, and the user simply wishes to transfer 

the Video Settings of each camera across, right-click and select . Then right-click on the camera to add the 

video settings to, and select .  
 
Note:  

• This is just the Video Feed settings; it will not add Video Motion Detection analytics. 

• Only copy onto cameras that have the same driver as the camera that has been copied. 
 

 Edit Existing Camera 

Note: If any changes are made to the setup of a camera that is currently multicasting, restart the streams. This 
simply entails removing and reselecting the cameras in the Cameras tab, after the settings are saved. 
 

 

Edit an already added 
camera by returning to 
Setup Tab → Configure 
Servers → Cameras, 
selecting a camera and 

clicking . This will 
bring up an interface with 
tabs containing the cameras 
editable details.  

 

 Repeated Options 

The camera setup options of General, Connection, Video Feeds, I/O, and PTZ are all dealt with in section 6a 
(above), and they will not be repeated here. However, the Pre-events, Access, and Privacy Zones tabs will be 
dealt with below. 
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Note: The Wizard goes through the process of setting up a Database, Scheduled Recordings, and Video Motion 
Algorithm triggered recordings; these appear as individual panels in Configure Servers and not as options within 
the Edit tabs.   

 Pre-events Tab 

 

Pre-events were setup under the Activity Recording section of the Wizard. The 
number of pre-events cannot be defined here, but the frame rate of the pre-
events may be defined in this tab. 

Note: JPEG is recorded in Key Frames, so there will only be the option of Frames per Second when setting the 
pre-events on a MJPEG stream. 
 

 Access Tab 

Under the Access tab, set up which user access levels have control of the different facets of the available 
cameras. 

  
 

 
 
 

 Important Note on Access Rights: 

1. All access levels on this unit are managed in the Access Rights Panel of the Server (Site → Open Tab → 
Setup → Configure Servers → Expand the Server → Access Rights).  

 
2. Access rights pertain to the access levels assigned to specific users. If a user is given level 1 access, and 

this camera is only assigned to other levels, that user will not see this camera. (Users are managed in 
the Site → Open Tab → Setup → Users).  

3. Non-admin users may be given the right to configure other non-admin users. See the main Setup manual 
for more information on this. 

 

 Audio Listen Access Right 

Live This controls which Access Levels can view the camera’s live feed 

Review This controls which Access Levels can review recorded footage form this camera. 

PTZ This controls which Access Levels can control PTZ movement. 

PTZ Menu This controls which Access Levels have the ability to change the PTZ menu. 

Set Presets   This controls which Access Levels can change PTZ Preset positions. 

Audio Listen This controls which Access levels can listen to the audio from the onboard mic. 

Hide privacy 
zones 

This controls which Access Levels can hide privacy zones on the camera image. 

Set All Selecting  will give this level access to all settings; selecting  will give this 
level access to none. 
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The table below details situations in which the Audio Listen access rights settings configured by the user do 
and do not apply.  

Audio Listen access right settings do apply to: Audio Listen access right settings do not apply to: 

Live viewing. Independent  audio channels. 

Reviewing from the camera tab. Archived video. 

Reviewing from the database tab (both video and 
integration databases). 

Connecting to a 2016.2 server using a 2015/2016.1 
viewer.  

Viewing  video when handling an alarm in the Alarm 
Management Gateway. 

Connecting to a 2016.1 server using a 2016.2 viewer. 

 

Note: When listening to reviewed audio, only a single audio channel will now play.  

 

 Privacy Zones 

 
 
Using privacy zones, certain areas of the camera image can be blocked from view. They can be hidden (removed) 
by operators who have been granted access rights to do so (see above). Otherwise, privacy zones can be set to 
blacken out the sensitive information on the camera image, and will reflect in snapshots, recordings, and review. 
 

 

Add a new privacy zone to the camera image. 

 
Clear all privacy zones from the camera image. 
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Clear only the selected zone from the camera image. 

 

Click this to show instructions on defining the shape of a privacy zone: 

 
 
 

 Camera Successfully Added 

 

The 
camera 
has now 
been set 
up and will 
start 
recording 
as 
configured
. From this 
screen, 
another 
camera 
can be 
added or 
the 
camera 
just set up 
can be 
edited.     

 View Camera/s 

 Open Site 

 

File → Open Site → Your_Sites_Name. 
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 Open the Cameras Tab 

 

File → Your_Sites_Name → 
Open Tab → Cameras.  

 

Double click on a camera in 
the Resources panel, to start 
viewing it 

 

 Middle Click on a Live Camera 

To change aspects of how the camera appears in a panel.  
 

 
 

Start audio: starts audio.  
Video format: Allows the user to select which of the camera’s video 
streams (which format/resolution) they wish to view.  
View transform: Allows transforming images for cameras with special 
lenses. (E.g. 360-degree cameras.) 
Overlays: Allows viewing the different analytics algorithm’s that have 
been applied to this camera’s feed, live in the Cameras Tab. 
Help: Pops-up a help window on Digital Zoom, and PTZ Control within this 
panel. 
Switch to review: Allows switching back and forth between live and review 
footage. 
Shrink panel: Reduces the size of the camera panel. 
Resize panel: Gives more resizing options. 
False colour: Changes the colour of the image to false colour. 
Clear panel: Removes the camera/s from the currently selected panel/s. 
Export Snapshot…: Opens a window to print snapshot, save to folder, copy 
to system clipboard, or copy to CathexisVision clipboard. Also choose to 
include the camera name and time of snapshot in the overlays. 

Cameras fullscreen: Fills the entire screen with the Cameras Panel; 
creating a Video Wall. The same procedure will exit fullscreen mode 

Open Motion Heatmap: Opens motion heatmap 
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 Middle-Click on a Camera in Review 

 
 

View transform: Allows transforming images for cameras 
with special lenses. (E.g. 360-degree cameras.) 
Select database: If multiple databases are set up, set a 
camera to record to a certain database using this option. 
Switch to live: Allows switching back and forth between live 
and review footage.  
Shrink panel: Reduces the size of the camera panel.  
Resize panel: Gives more resizing options. 
False colour: Changes the colour of the image to false 
colour. 
Clear panel: Removes the camera/s from the currently 
selected panel/s. 
Export snapshot…: Opens a window to print snapshot, save 
to folder, copy to system clipboard, or copy to 
CathexisVision clipboard. Also choose to include the camera 
name and time of snapshot in the overlays. 
Smart search: Use snap-search feature to search the 
database for snapshots similar to the current image.  

Cameras fullscreen: Fills the entire screen with the 
Cameras Panel; creating a Video Wall. The same procedure 
will exit fullscreen mode. 

Open motion heatmap: opens motion heatmap 
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7 Events 

 
Events are located under Site→ Setup→ Events. 
When creating VMD, it will immediately be added as an event. This VMD setup can be used in other events 
though. From the Events panel, edit current events, create new events, or delete events that are no longer 
desired. 
 
Double clicking on, or editing, an event will allow adjusting the Schedule, Resources, Triggers, and Actions as 
required. 

 
• A Trigger is what sets off an event. There can be more than one trigger per event (e.g. VMD from two 

cameras will cause the same Action). 

• Actions are the actions taken by the system as a result of the Trigger. 
 
Note: The “Resources” section pertains to the ability to switch the display on a Client Viewing PC [to a relevant 
camera’s stream], as a result of an action. This does not affect which cameras will be recorded.  
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8 Uninstall 

To uninstall, simply follow the uninstallation process that is native to the operating system on which 
CathexisVision was  installed. 

 

 

 

 




